
Q .1Q .1 Who among the fo l lowing is  the head of the government in the S tates  of Ind ia?Who among the fo l lowing is  the head of the government in the S tates  of Ind ia?
A nsA ns 1. Chief Minister

2. Governor
3. Prime Minister
4. President

Q .2Q .2 S ree Naray ana G uru s tarted S ree Naray ana Dharma Par ipalana Yogam ( S NDP)  toS ree Naray ana G uru s tarted S ree Naray ana Dharma Par ipalana Yogam ( S NDP)  to
c arry  on the work  of s oc ia l  reform in _______ .c arry  on the work  of s oc ia l  reform in _______ .

A nsA ns 1. Bihar
2. Assam
3. Maharashtra
4. Kerala

Q .3Q .3 Whic h of the fo l lowing reform movements  was  s tarted in M umbai  in 1 867  toWhic h of the fo l lowing reform movements  was  s tarted in M umbai  in 1 867  to
empower people to  bel ieve in the exis tence of 'one G od '?empower people to  bel ieve in the exis tence of 'one G od '?

A nsA ns 1. Ved Samaj
2. Satyashodhak Samaj
3. Brahmo Samaj
4. Prarthana Samaj

Q .4Q .4 Whic h of the fo l lowing places  was  c aptured by  the army  led  by  A kbar  in 1 568?Whic h of the fo l lowing places  was  c aptured by  the army  led  by  A kbar  in 1 568?
A nsA ns 1. Kashmir

2. Qandahar
3. Sisodiya capital of Chittor
4. Parts of Ahmadnagar
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Q . 5Q . 5 A s  per  C ens us  2 0 1 1 ,  whic h Indian s tate has  the lowes t  populat ion dens ity ?A s  per  C ens us  2 0 1 1 ,  whic h Indian s tate has  the lowes t  populat ion dens ity ?
A nsA ns 1. Himachal Pradesh

2. Arunachal Pradesh
3. Sikkim
4. Mizoram

Q .6Q .6 Whic h M ughal  E mperor  pers onal ly  managed c ampaigns  in the Decc an agains t  theWhic h M ughal  E mperor  pers onal ly  managed c ampaigns  in the Decc an agains t  the
M arathas  who s tarted guerr i l la  warfare?M arathas  who s tarted guerr i l la  warfare?

A nsA ns 1. 
2. 
3. 
4. 

Q .7Q .7 In whic h s tate is  the famous  temple ‘Hanuman G arhi ’ loc ated?In whic h s tate is  the famous  temple ‘Hanuman G arhi ’ loc ated?
A nsA ns 1. Bihar

2. Tamil Nadu
3. Uttar Pradesh
4. Chhattisgarh

Q .8Q .8 In O c tober  2 0 24 ,  whic h s tate government launc hed an init iat ive c al led  'S ankalp' ,In  O c tober  2 0 24 ,  whic h s tate government launc hed an init iat ive c al led  'S ankalp' ,
whic h aims  to  tac k le drug traffic king and s upport  rehabi l itat ion efforts?whic h aims  to  tac k le drug traffic king and s upport  rehabi l itat ion efforts?

A nsA ns 1. Kerala
2. Haryana
3. Himachal Pradesh
4. Punjab

Q .9Q .9 Whic h of the fo l lowing hi l ls  is  loc ated in M aharas htra?Whic h of the fo l lowing hi l ls  is  loc ated in M aharas htra?
A nsA ns 1. Satmala hills

2. Garo hills
3. Aravalli hills
4. Gir hills
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Q .1 0Q .1 0 In the c ons t ituent as s embly  of Ind ia ,  who among the fo l lowing quoted ' theIn the c ons t ituent as s embly  of Ind ia ,  who among the fo l lowing quoted ' the
Pres ident is  the s y mbol  of  Nat ion'?Pres ident is  the s y mbol  of  Nat ion'?

A nsA ns 1. Dr. BR Ambedkar
2. Dr. Sacchidananda Sinha
3. KM Munshi
4. Jawahar Lal Nehru

Q .1 1Q .1 1 Whic h team won Pro Kabaddi  2 0 24 ?Whic h team won Pro Kabaddi  2 0 24 ?
A nsA ns 1. 

2. 
3. 
4. 

Q .1 2Q .1 2 I IFL  Finance has  rebranded s even of its  branc hes  as  a l l - women s taffed ‘S hakt i ’I IFL  Finance has  rebranded s even of its  branc hes  as  a l l - women s taffed ‘S hakt i ’
branc hes  to  promote women empowerment .  In whic h regions  are thes e branc hesbranc hes  to  promote women empowerment .  In whic h regions  are thes e branc hes
loc ated?loc ated?

A nsA ns 1. Delhi NCR and Mumbai MMR
2. Chennai and Kolkata
3. Bengaluru and Hyderabad
4. Pune and Ahmedabad

Q .1 3Q .1 3 To promote the s tudy  of A rabic ,  Pers ian,  and Is lamic  laws ,  the C alc utta M adras aTo promote the s tudy  of A rabic ,  Pers ian,  and Is lamic  laws ,  the C alc utta M adras a
was  es tabl is hed by  Warren Has t ings  in the _____ .was  es tabl is hed by  Warren Has t ings  in the _____ .

A nsA ns 1. 1750s
2. 1780s
3. 1790s
4. 1720s

Q .1 4Q .1 4 Whic h of the fo l lowing s tatements  about the S hival ik  range is  c orrec t?Whic h of the fo l lowing s tatements  about the S hival ik  range is  c orrec t?
A nsA ns 1. It has an average elevation of 4000–5000 metres.

2. It is the outermost range of the Himalayas stretching from the Indus to the
Brahmaputra.

3. It stretches between the Ganga and Yamuna rivers.
4. It is the innermost range of the Himalayas.
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Q .1 5Q .1 5 The s ec ond phas e of the C ens us  of Ind ia  2 0 1 1 ,  known as  Populat ion E numerat ion,The s ec ond phas e of the C ens us  of Ind ia  2 0 1 1 ,  known as  Populat ion E numerat ion,
was  c onduc ted in whic h month of 2 0 1 1 ?was  c onduc ted in whic h month of 2 0 1 1 ?

A nsA ns 1. July
2. June
3. January
4. February

Q .1 6Q .1 6 Who d id  Kr is tal ina G eorgieva ,  M anaging Direc tor  of  the IM F,  propos e to  appointWho d id  Kr is tal ina G eorgieva ,  M anaging Direc tor  of  the IM F,  propos e to  appoint
as  the deputy  managing d irec tor,  effec t ive 3 1  O c tober  2 0 24 ?as  the deputy  managing d irec tor,  effec t ive 3 1  O c tober  2 0 24 ?

A nsA ns 1. Janet Yellen
2. Christine Lagarde
3. Raghuram Rajan
4. Nigel Clarke

Q .1 7Q .1 7 When was  the firs t  Bac kward C las s es  C ommis s ion appointed?When was  the firs t  Bac kward C las s es  C ommis s ion appointed?
A nsA ns 1. 1955

2. 1957
3. 1953
4. 1954

Q .1 8Q .1 8 Who among the fo l lowing was  the firs t  Deputy  Pr ime M inis ter  of  Ind ia?Who among the fo l lowing was  the firs t  Deputy  Pr ime M inis ter  of  Ind ia?
A nsA ns 1. Sardar Vallabhbhai Patel

2. Gulzarilal Nanda
3. Morarji Desai
4. Jagjivan Ram

Q .1 9Q .1 9 Whic h of the fo l lowing c ontr ibutions  is  as s oc iated with Prof.  Padmanabhan in theWhic h of the fo l lowing c ontr ibutions  is  as s oc iated with Prof.  Padmanabhan in the
field  of biotec hnology ?field  of biotec hnology ?

A nsA ns 1. Discovered insulin analogues and headed WHO health programs
2. Developed India's first vaccine against dengue and COVID-19
3. Created BIRAC and pioneered biotech research on malaria parasite

4. Led India's genome sequencing mission at IISER Pun
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Q .2 0Q .2 0 Whic h of the fo l lowing c ountr ies  was  elec ted as  one of the non- permanentWhic h of the fo l lowing c ountr ies  was  elec ted as  one of the non- permanent
members  of the United Nations  S ec ur ity  C ounc i l  for  a  two- y ear  term s tart ing onmembers  of the United Nations  S ec ur ity  C ounc i l  for  a  two- y ear  term s tart ing on
1  January  2 0 2 5?1  January  2 0 2 5?

A nsA ns 1. Japan
2. Switzerland
3. Pakistan
4. South Korea

Q .2 1Q .2 1 S ix  fr iends ,  P,  Q ,  R,  S,  T,  and U are s itt ing in a  row,  fac ing north.  T  is  an immediateS ix  fr iends ,  P,  Q ,  R,  S,  T,  and U are s itt ing in a  row,  fac ing north.  T  is  an immediate
neighbour  of both S  and R.  Q  is  to  the immediate r ight  of R.  P  is  s itt ing to  the leftneighbour  of both S  and R.  Q  is  to  the immediate r ight  of R.  P  is  s itt ing to  the left
of S.  Q  is  the immediate neighbour  of R and U.  Who s its  to  the immediate left  ofof S.  Q  is  the immediate neighbour  of R and U.  Who s its  to  the immediate left  of
R?R?

A nsA ns 1. T
2. Q
3. P
4. S

Q .2 2Q .2 2 If  ‘E ’ s tands  for  ‘÷ ’ ,  ‘F ’ s tands  for  ‘× ’ ,  ‘G ’ s tands  for  ‘+ ’ ,  and ‘H ’ s tands  for  ‘− ’ ,  thenIf  ‘E ’ s tands  for  ‘÷ ’ ,  ‘F ’ s tands  for  ‘× ’ ,  ‘G ’ s tands  for  ‘+ ’ ,  and ‘H ’ s tands  for  ‘− ’ ,  then
the res ultant  of whic h of the fo l lowing would  be 84 ?the res ultant  of whic h of the fo l lowing would  be 84 ?

A nsA ns 1. 144 E 2 H 24 G 12 F 3
2. 120 H 48 E 24 G 2 F 1
3. 180 F 1 E 3 H 18 G 6
4. 150 G 30 H 18 F 1 E 2

Q .2 3Q .2 3 S ix  boxes  P,  Q ,  R,  S,  T,  and U are s tac ked one above the other  but not  neces s ar i lyS ix  boxes  P,  Q ,  R,  S,  T,  and U are s tac ked one above the other  but not  neces s ar i ly
in the s ame order.  T  is  kept third  from the top.  O nly  two boxes  are kept betweenin the s ame order.  T  is  kept third  from the top.  O nly  two boxes  are kept between
T and R.  Q  is  kept immediately  below U.  There is  exac t ly  one box between P  and U.T  and R.  Q  is  kept immediately  below U.  There is  exac t ly  one box between P  and U.
S  is  kept immediately  above P.  Whic h box is  s ec ond from the bottom?S  is  kept immediately  above P.  Whic h box is  s ec ond from the bottom?

A nsA ns 1. P
2. Q
3. S
4. U
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Q .24Q .24 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

7  7  2 0  2 0  3 3  3 3  4 6 4 6 59 59 ??
A nsA ns 1. 77

2. 75
3. 72
4. 69

Q .2 5Q .2 5 E ac h vowel  in the word DE A FIS H is  c hanged to  the letter  immediately  fo l lowing itE ac h vowel  in the word DE A FIS H is  c hanged to  the letter  immediately  fo l lowing it
in the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to  the letterin the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to  the letter
immediately  preceding it  in the E ngl is h a lphabetic al  order.  How many  letters  wi l limmediately  preceding it  in the E ngl is h a lphabetic al  order.  How many  letters  wi l l
appear  exac t ly  twice in the new group of letters  thus  formed?appear  exac t ly  twice in the new group of letters  thus  formed?

A nsA ns 1. Two
2. One
3. None
4. Three

Q .2 6Q .2 6 In the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent oneIn the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent one
fol lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  thefo l lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  the
s ame logic .s ame logic .

JUNG  -  UNJG  -  G NUJJUNG  -  UNJG  -  G NUJ
S KIT  -  KIS T -  T IKSS KIT  -  KIS T -  T IKS

A nsA ns 1. LACE - ACLE - ECAL
2. GRIP - RGIP - PRIG
3. BOXS - BXOS - SXOB
4. COME - OMCE - OMEC
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Q .2 7Q .2 7 S elec t  the tr iad  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two tr iadsS elec t  the tr iad  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two tr iads
given below.  Both tr iads  fo l low the s ame pattern.  given below.  Both tr iads  fo l low the s ame pattern.  

FD -  G C  -  HBFD -  G C  -  HB
M K -  NJ  -  O IM K -  NJ  -  O I

A nsA ns 1. OM - RN - AG
2. RP - SO -TN
3. IK - UQ - MS
4. SQ - IM - MG

Q .2 8Q .2 8 Identify  the figure given in the options  whic h when put in place of '? '  wi l l  logic al lyIdentify  the figure given in the options  whic h when put in place of '? '  wi l l  logic al ly
c omplete the s er ies .c omplete the s er ies .

A nsA ns 1. 

2. 

3. 

4. 
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Q .2 9Q .2 9 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are theS elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the
numbers  of the fo l lowing s ets .numbers  of the fo l lowing s ets .

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding/s ubtrac t ing/mult iply ing etc .  to  1 3,  c an be performed.  Break ing down 1 3as  adding/s ubtrac t ing/mult iply ing etc .  to  1 3,  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )a l lowed . )

( 1 ,  50 ,  5)( 1 ,  50 ,  5)
( 6 ,  24 0 ,  4)( 6 ,  24 0 ,  4)

A nsA ns 1. (8, 25, 3)
2. (9, 400, 5)
3. (7,140, 2)
4. (4, 120, 4)

Q .3 0Q .3 0 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are theS elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the
numbers  of the fo l lowing s ets .numbers  of the fo l lowing s ets .

( NO TE  :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE  :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  its  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h asdown the numbers  into  its  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as
adding /  s ubtrac t ing /mult iply ing etc .  to  1 3  c an be performed.  Break ing down 1 3adding /  s ubtrac t ing /mult iply ing etc .  to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed)al lowed)

( 6 ,2 5,4 6)( 6 ,2 5,4 6)
( 1 6 ,2 3, 54)( 1 6 ,2 3, 54)

A nsA ns 1. (4,7,26)
2. (13,8,26)
3. (8,17,30)
4. (27,2,24)
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Q .3 1Q .3 1 Three of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form aThree of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a
group.  Whic h word- pair  DO E S  NO T belong to  that  group?group.  Whic h word- pair  DO E S  NO T belong to  that  group?

( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not
be related to  eac h other  bas ed on the number of letters/number ofbe related to  eac h other  bas ed on the number of letters/number of
c ons onants/vowels  in the word . )c ons onants/vowels  in the word . )

A nsA ns 1. Crockery : Forks
2. Stationery : Pen
3. Furniture : Chair
4. Cutlery : Spoon

Q .3 2Q .3 2 The pos it ion(s)  of  how many  letters  wi l l  remain unc hanged if  eac h of the lettersThe pos it ion(s)  of  how many  letters  wi l l  remain unc hanged if  eac h of the letters
in the word BRA IN is  arranged in the E ngl is h a lphabetic al  order?in the word BRA IN is  arranged in the E ngl is h a lphabetic al  order?

A nsA ns 1. Three
2. Two
3. Zero
4. One

Q .3 3Q .3 3

A nsA ns 1. 
2. 
3. 
4. 
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Q .3 4Q .3 4 Refer  to  the fo l lowing s er ies  of  three- letter  words  and ans wer  the ques t ion thatRefer  to  the fo l lowing s er ies  of  three- letter  words  and ans wer  the ques t ion that
fo l lows .fo l lows .
A IN,  O NK,  A S T,  E JOA IN,  O NK,  A S T,  E JO
If  eac h letter  in a l l  the words  is  replaced by  the next  letter  in the E ngl is hIf  eac h letter  in a l l  the words  is  replaced by  the next  letter  in the E ngl is h
alphabetic al  order,  how many  of the res ult ing words  wi l l  NO T c ontain any  vowels?alphabetic al  order,  how many  of the res ult ing words  wi l l  NO T c ontain any  vowels?

A nsA ns 1. Four
2. One
3. Two
4. Three

Q .3 5Q .3 5 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?  What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?  

96 96 1 3 8 1 3 8 1 80  1 80  2 2 2  2 2 2  2 64  2 64  ??
A nsA ns 1. 

2. 
3. 
4. 

Q .3 6Q .3 6 Refer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting toRefer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to
be done from left  to  r ight  only .be done from left  to  r ight  only .

( L eft)  ( L eft)  O O P J A R A N I D E H R E W A L I B U D A Y X Z G FO O P J A R A N I D E H R E W A L I B U D A Y X Z G F ( Right)( Right)
If  a l l  the c ons onants  are dropped from the s er ies ,  whic h letter  wi l l  be fifth fromIf a l l  the c ons onants  are dropped from the s er ies ,  whic h letter  wi l l  be fifth from
the r ight?the r ight?

A nsA ns 1. I
2. E
3. A
4. O
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Q .3 7Q .3 7 In the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent oneIn the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent one
fol lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  thefo l lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  the
s ame logic .s ame logic .

JUS T -  JTS U -  TS UJJUS T -  JTS U -  TS UJ
WO RE  -  WE RO  -  E RO WWO RE  -  WE RO  -  E RO W

A nsA ns 1. COST - CSOT - TSOC
2. LION - LINO - IONL
3. BANG - ABNG - GANB
4. MIST - MTSI - TSIM

Q .3 8Q .3 8 If  2  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in theIf  2  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the
number 1 3 2 871 4 ,  then how many  d igits  wi l l  appear  more than twice in the newnumber 1 3 2 871 4 ,  then how many  d igits  wi l l  appear  more than twice in the new
number this  formed?number this  formed?

A nsA ns 1. Three
2. Two
3. None
4. One

Q .3 9Q .3 9 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter- c lus ter. )pos it ion in the letter- c lus ter. )

A nsA ns 1. DBE
2. RQS
3. ZXA
4. GEH

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .4 0Q .4 0 If  ‘A’ s tands  for  ‘+ ’ ,  ‘B ’ s tands  for  ‘− ’ ,  ‘C ’ s tands  for  ‘× ’ and ‘D ’ s tands  for  ‘÷ ’ ,  thenIf  ‘A’ s tands  for  ‘+ ’ ,  ‘B ’ s tands  for  ‘− ’ ,  ‘C ’ s tands  for  ‘× ’ and ‘D ’ s tands  for  ‘÷ ’ ,  then
what wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation?what wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation?

9 A  2  B  1  A  6  D  3  C  2  = ?9 A  2  B  1  A  6  D  3  C  2  = ?
A nsA ns 1. 34

2. 24
3. 04
4. 14

Q .4 1Q .4 1 S elec t  the mos t appropr iate meaning of the given word .S elec t  the mos t appropr iate meaning of the given word .

Ruthles sRuthles s
A nsA ns 1. Polished

2. Malicious
3. Modest
4. Compassionate

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
They  l ive in a  ___ hous e near  the lake.They  l ive in a  ___ hous e near  the lake.

A nsA ns 1. stoned
2. stone
3. stony
4. stoner

Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
By  the t ime s he arr ives ,  we ___ a lready  left .By  the t ime s he arr ives ,  we ___ a lready  left .

A nsA ns 1. has
2. had
3. will
4. will have

Section : General English and Comprehension
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Q .4 4Q .4 4 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

To be a  piece of c akeTo be a  piece of c ake
A nsA ns 1. To be moderately challenging

2. To be very difficult
3. To be impossible
4. To be very easy

Q .4 5Q .4 5 S elec t  the option that  has  the s ame meaning as  the under l ined group of words .S elec t  the option that  has  the s ame meaning as  the under l ined group of words .

S he has  a lway s  thought about how tec hnology  c an S he has  a lway s  thought about how tec hnology  c an c aus e,  ac t ,  or  move in ac aus e,  ac t ,  or  move in a
s pec ia l  ways pec ial  way  people c los er  together  and give people more t ime bac k . people c los er  together  and give people more t ime bac k .

A nsA ns 1. bring
2. conjecture
3. signify
4. postulate
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Dukhi loved bright colours, especially reds and yellows. He liked strongly scented flowers,
like jasmine and honeysuckle. He couldn't understand my father's preference for the more
delicately perfumed petunias and sweet peas. But I shared Dukhi's fondness for the
common bright orange marigold, which is offered in temples and is used to make garlands
and nosegays. When the garden was bare of all colour, the marigold would still be there,
gay and flashy, challenging the sun. 
Dukhi was very fond of making nosegays, and I liked to watch him at work. A sunflower
formed the centrepiece. It was surrounded by roses, marigolds and oleander, fringed with
green leaves, and bound together with silver thread. The perfume was overpowering. The
nosegays were presented to me or my father on special occasions, that is, on a birthday or
to guests of my father's who were considered important.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 S elec t  the mos t appropr iate tone of the pas s age.S elec t  the mos t appropr iate tone of the pas s age.
A nsA ns 1. Affectionate

2. Condescending
3. Disturbed
4. Aggressive
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Dukhi loved bright colours, especially reds and yellows. He liked strongly scented flowers,
like jasmine and honeysuckle. He couldn't understand my father's preference for the more
delicately perfumed petunias and sweet peas. But I shared Dukhi's fondness for the
common bright orange marigold, which is offered in temples and is used to make garlands
and nosegays. When the garden was bare of all colour, the marigold would still be there,
gay and flashy, challenging the sun. 
Dukhi was very fond of making nosegays, and I liked to watch him at work. A sunflower
formed the centrepiece. It was surrounded by roses, marigolds and oleander, fringed with
green leaves, and bound together with silver thread. The perfume was overpowering. The
nosegays were presented to me or my father on special occasions, that is, on a birthday or
to guests of my father's who were considered important.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 S elec t  the mos t appropr iate t it le for  the pas s age.S elec t  the mos t appropr iate t it le for  the pas s age.
A nsA ns 1. My Father And His Garden

2. Dukhi and His Hobby
3. My Beautiful Flowers
4. Dukhi And His Love For Flowers
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Dukhi loved bright colours, especially reds and yellows. He liked strongly scented flowers,
like jasmine and honeysuckle. He couldn't understand my father's preference for the more
delicately perfumed petunias and sweet peas. But I shared Dukhi's fondness for the
common bright orange marigold, which is offered in temples and is used to make garlands
and nosegays. When the garden was bare of all colour, the marigold would still be there,
gay and flashy, challenging the sun. 
Dukhi was very fond of making nosegays, and I liked to watch him at work. A sunflower
formed the centrepiece. It was surrounded by roses, marigolds and oleander, fringed with
green leaves, and bound together with silver thread. The perfume was overpowering. The
nosegays were presented to me or my father on special occasions, that is, on a birthday or
to guests of my father's who were considered important.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 S elec t  the mos t appropr iate s truc ture of the pas s age.S elec t  the mos t appropr iate s truc ture of the pas s age.
A nsA ns 1. Argumentative

2. Cause and effect
3. Circular
4. Linear
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Dukhi loved bright colours, especially reds and yellows. He liked strongly scented flowers,
like jasmine and honeysuckle. He couldn't understand my father's preference for the more
delicately perfumed petunias and sweet peas. But I shared Dukhi's fondness for the
common bright orange marigold, which is offered in temples and is used to make garlands
and nosegays. When the garden was bare of all colour, the marigold would still be there,
gay and flashy, challenging the sun. 
Dukhi was very fond of making nosegays, and I liked to watch him at work. A sunflower
formed the centrepiece. It was surrounded by roses, marigolds and oleander, fringed with
green leaves, and bound together with silver thread. The perfume was overpowering. The
nosegays were presented to me or my father on special occasions, that is, on a birthday or
to guests of my father's who were considered important.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 S elec t  the option that  is  NO T a fac t  pres ented in the pas s age.S elec t  the option that  is  NO T a fac t  pres ented in the pas s age.
A nsA ns 1. Dukhi presented nosegays to the writer's father and him

2. Marigold would still be there challenging the sun
3. Dukhi's fondness for sweet peas and petunias
4. Dukhi loved colours like reds and yellows
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Dukhi loved bright colours, especially reds and yellows. He liked strongly scented flowers,
like jasmine and honeysuckle. He couldn't understand my father's preference for the more
delicately perfumed petunias and sweet peas. But I shared Dukhi's fondness for the
common bright orange marigold, which is offered in temples and is used to make garlands
and nosegays. When the garden was bare of all colour, the marigold would still be there,
gay and flashy, challenging the sun. 
Dukhi was very fond of making nosegays, and I liked to watch him at work. A sunflower
formed the centrepiece. It was surrounded by roses, marigolds and oleander, fringed with
green leaves, and bound together with silver thread. The perfume was overpowering. The
nosegays were presented to me or my father on special occasions, that is, on a birthday or
to guests of my father's who were considered important.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 S elec t  the mos t appropr iate s y nony m of the word ' fr inged ' .S elec t  the mos t appropr iate s y nony m of the word ' fr inged ' .
A nsA ns 1. Centred

2. Bordered
3. Braided
4. Tousled

Q . 51Q . 51 Vद एVद ए   ग एग ए   वा \वा \   म^म^   _र a_र a   bा नbा न   केके   fलएfलए   उ प युaउ प युa   शmशm   चुन^चुन^ ।।
pवqा लयpवqा लय   म^म^  ……… . .   ……… . .  वा ता वर णवा ता वर ण   हैहै  ? ?

A nsA ns 1. कैसा
2. कैसे
3. कैस
4. कैसी

Section : General Hindi and Comprehension
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Q . 52Q . 52 लो को zaलो को za   केके   सहीसही   अथ}अथ}   काका   चयनचयन   क र̂क र̂ --
‘‘ कं गा लीकं गा ली   म^म^   आ टाआ टा   गी लागी ला ’’

A nsA ns 1. बहुत थोड़ी व�ु से आव�कता क� पूpत} नह� होती
2. एक मुसीबत पर दूसर� मुसीबत आ पड़ना
3. आटे म̂ अ�धक पानी zगरना
4. गर�बी म̂ आटा गीला होना

Q . 53Q . 53 pन�fल�ख तpन�fल�ख त   pवक ��pवक ��   म^म^   सेसे  ‘ ‘ त टत ट ’ ’ काका   प य� यवा चीप य� यवा ची   कौ नकौ न -- सासा   हैहै ??
A nsA ns 1. िकनारा

2. Vदशा
3. pनध}न
4. f��

Q . 54Q . 54 pन�fल�ख तpन�fल�ख त   pवक ��pवक ��   म^म^   सेसे   आ कंु चनआ कंु चन   काका   pवलो मpवलो म   शmशm   प हचा न^प हचा न^ ।।
A nsA ns 1. आ��त

2. pव�ार
3. संकोच
4. कंचन

Q . 55Q . 55 '' खूंटेखूंटे   केके   बलबल   कू द नाकू द ना '  '  मुहा वरेमुहा वरे   काका   सहीसही   अथ}अथ}   हो गाहो गा --
A nsA ns 1. बुरे Vदन आना

2. कोई सहारा pमलने पर अकड़ना
3. कड़ा दंड देना
4. गु� मं�णा करना
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C omprehens ion:C omprehens ion:
Vदए गए गq�श के आधार पर pन��िकत ��� के उ�र दीfजए-- 
गqगीत म̂ भाषा गq क� होती है और भाव पq का, अथ�तः गq ¢पी शर�र म̂ का£ ¢पी आ¤ा का pनवास होता है।
इसक� भाषा सामा¦ गq क� अपे�ा सरस और लयब§ होती है। अलंकार� का खुलकर �योग िकया जाता है।
कहानी क� संवेदना और भावाpतरेक इसक� �मुख pवशेषताएं ह̈। का£ के सम� जीवंत त© गq गीत म̂ पाये जाते
ह̈। माpम}क भाव, मनोरम अथ}, सुगVठत �ौढ़ भाषा, रस, अलंकार, ¬pन का समावेश आव�क है। िकसी pवशेष
अनुभूpत या भाव को क̂­ म̂ रखकर यह® उसका pवकास िकया जाता है। यqिप गqगीत £zaगत होते ह̈ िकंतु इनम̂
मानfसकता का pववेचन और मानवीय सहानुभूpत के कारण सामा¦ जन के �pत एक आ¤ीयता का भाव पाया जाता
है। वह अपने पाठक को हँसाने या °लाने क� �मता रखती है। यथाथ} क� ती± अनुभूpत के कारण ही यह रचना
सामा¦ गq से ऊपर उठकर गqगीत का ¢प ³हण करती है और उप¦ास, नाटक, कहानी आVद से �भ´ हो जाती
है। भाव� क� मुa अनुभूpत और अ�भ£ंजना जब गq म̂ होती है तो गqका£ का ¢प ले लेती है।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 ग qग q   गी तगी त   केके   fलएfलए   pन�pन�   म^म^   सेसे   \ा\ा   आ व�कआ व�क   नह�नह�   हैहै ??
A nsA ns 1. माpम}क भाव

2. सुगVठत �ौढ़ भाषा
3. मनोरम अथ}
4. वण}ना¤कता
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C omprehens ion:C omprehens ion:
Vदए गए गq�श के आधार पर pन��िकत ��� के उ�र दीfजए-- 
गqगीत म̂ भाषा गq क� होती है और भाव पq का, अथ�तः गq ¢पी शर�र म̂ का£ ¢पी आ¤ा का pनवास होता है।
इसक� भाषा सामा¦ गq क� अपे�ा सरस और लयब§ होती है। अलंकार� का खुलकर �योग िकया जाता है।
कहानी क� संवेदना और भावाpतरेक इसक� �मुख pवशेषताएं ह̈। का£ के सम� जीवंत त© गq गीत म̂ पाये जाते
ह̈। माpम}क भाव, मनोरम अथ}, सुगVठत �ौढ़ भाषा, रस, अलंकार, ¬pन का समावेश आव�क है। िकसी pवशेष
अनुभूpत या भाव को क̂­ म̂ रखकर यह® उसका pवकास िकया जाता है। यqिप गqगीत £zaगत होते ह̈ िकंतु इनम̂
मानfसकता का pववेचन और मानवीय सहानुभूpत के कारण सामा¦ जन के �pत एक आ¤ीयता का भाव पाया जाता
है। वह अपने पाठक को हँसाने या °लाने क� �मता रखती है। यथाथ} क� ती± अनुभूpत के कारण ही यह रचना
सामा¦ गq से ऊपर उठकर गqगीत का ¢प ³हण करती है और उप¦ास, नाटक, कहानी आVद से �भ´ हो जाती
है। भाव� क� मुa अनुभूpत और अ�भ£ंजना जब गq म̂ होती है तो गqका£ का ¢प ले लेती है।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 ग qग q   गी तगी त   क�क�   भा षाभा षा   कै सीकै सी   हो तीहो ती   हैहै ??
A nsA ns 1. सरल और प_रpनिµत

2. सरस और लयब§
3. सहज और सुबोध
4. za¶ और प_रमाfज}त
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C omprehens ion:C omprehens ion:
Vदए गए गq�श के आधार पर pन��िकत ��� के उ�र दीfजए-- 
गqगीत म̂ भाषा गq क� होती है और भाव पq का, अथ�तः गq ¢पी शर�र म̂ का£ ¢पी आ¤ा का pनवास होता है।
इसक� भाषा सामा¦ गq क� अपे�ा सरस और लयब§ होती है। अलंकार� का खुलकर �योग िकया जाता है।
कहानी क� संवेदना और भावाpतरेक इसक� �मुख pवशेषताएं ह̈। का£ के सम� जीवंत त© गq गीत म̂ पाये जाते
ह̈। माpम}क भाव, मनोरम अथ}, सुगVठत �ौढ़ भाषा, रस, अलंकार, ¬pन का समावेश आव�क है। िकसी pवशेष
अनुभूpत या भाव को क̂­ म̂ रखकर यह® उसका pवकास िकया जाता है। यqिप गqगीत £zaगत होते ह̈ िकंतु इनम̂
मानfसकता का pववेचन और मानवीय सहानुभूpत के कारण सामा¦ जन के �pत एक आ¤ीयता का भाव पाया जाता
है। वह अपने पाठक को हँसाने या °लाने क� �मता रखती है। यथाथ} क� ती± अनुभूpत के कारण ही यह रचना
सामा¦ गq से ऊपर उठकर गqगीत का ¢प ³हण करती है और उप¦ास, नाटक, कहानी आVद से �भ´ हो जाती
है। भाव� क� मुa अनुभूpत और अ�भ£ंजना जब गq म̂ होती है तो गqका£ का ¢प ले लेती है।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 pन�pन�   म^म^   सेसे   '' जी वंतजी वंत '  '  काका   pवलो मpवलो म   शmशm   हैहै - -- -
A nsA ns 1. सुंदर

2. सामा¦
3. चु�
4. pन·भ
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C omprehens ion:C omprehens ion:
Vदए गए गq�श के आधार पर pन��िकत ��� के उ�र दीfजए-- 
गqगीत म̂ भाषा गq क� होती है और भाव पq का, अथ�तः गq ¢पी शर�र म̂ का£ ¢पी आ¤ा का pनवास होता है।
इसक� भाषा सामा¦ गq क� अपे�ा सरस और लयब§ होती है। अलंकार� का खुलकर �योग िकया जाता है।
कहानी क� संवेदना और भावाpतरेक इसक� �मुख pवशेषताएं ह̈। का£ के सम� जीवंत त© गq गीत म̂ पाये जाते
ह̈। माpम}क भाव, मनोरम अथ}, सुगVठत �ौढ़ भाषा, रस, अलंकार, ¬pन का समावेश आव�क है। िकसी pवशेष
अनुभूpत या भाव को क̂­ म̂ रखकर यह® उसका pवकास िकया जाता है। यqिप गqगीत £zaगत होते ह̈ िकंतु इनम̂
मानfसकता का pववेचन और मानवीय सहानुभूpत के कारण सामा¦ जन के �pत एक आ¤ीयता का भाव पाया जाता
है। वह अपने पाठक को हँसाने या °लाने क� �मता रखती है। यथाथ} क� ती± अनुभूpत के कारण ही यह रचना
सामा¦ गq से ऊपर उठकर गqगीत का ¢प ³हण करती है और उप¦ास, नाटक, कहानी आVद से �भ´ हो जाती
है। भाव� क� मुa अनुभूpत और अ�भ£ंजना जब गq म̂ होती है तो गqका£ का ¢प ले लेती है।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 ग q गी तग q गी त   हो त ेहो त े   ह̈ह̈  – –
A nsA ns 1. £zaगत

2. सामाfजक
3. लोकपरक
4. धाpम}क
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C omprehens ion:C omprehens ion:
Vदए गए गq�श के आधार पर pन��िकत ��� के उ�र दीfजए-- 
गqगीत म̂ भाषा गq क� होती है और भाव पq का, अथ�तः गq ¢पी शर�र म̂ का£ ¢पी आ¤ा का pनवास होता है।
इसक� भाषा सामा¦ गq क� अपे�ा सरस और लयब§ होती है। अलंकार� का खुलकर �योग िकया जाता है।
कहानी क� संवेदना और भावाpतरेक इसक� �मुख pवशेषताएं ह̈। का£ के सम� जीवंत त© गq गीत म̂ पाये जाते
ह̈। माpम}क भाव, मनोरम अथ}, सुगVठत �ौढ़ भाषा, रस, अलंकार, ¬pन का समावेश आव�क है। िकसी pवशेष
अनुभूpत या भाव को क̂­ म̂ रखकर यह® उसका pवकास िकया जाता है। यqिप गqगीत £zaगत होते ह̈ िकंतु इनम̂
मानfसकता का pववेचन और मानवीय सहानुभूpत के कारण सामा¦ जन के �pत एक आ¤ीयता का भाव पाया जाता
है। वह अपने पाठक को हँसाने या °लाने क� �मता रखती है। यथाथ} क� ती± अनुभूpत के कारण ही यह रचना
सामा¦ गq से ऊपर उठकर गqगीत का ¢प ³हण करती है और उप¦ास, नाटक, कहानी आVद से �भ´ हो जाती
है। भाव� क� मुa अनुभूpत और अ�भ£ंजना जब गq म̂ होती है तो गqका£ का ¢प ले लेती है।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 pन�pन�   म^म^   सेसे   ग q गी तग q गी त   क�क�   pवशेष ताpवशेष ता   नह�नह�   हैहै ——
A nsA ns 1. इसम̂ का£ के सभी जीवंत त¹ होते ह̈◌ं।

2. इसम̂ अलंकार� का �योग िकया जाता है।
3. इसक� भाषा दुब»ध और अतुक�त होती है।
4. इसम̂ कहानी क� संवेदना और भावाpतरेक रहता है।

Q .61Q .61 Whic h ty pe of c hart  in M S - E xcel  2 0 1 6 d is play s  both c o lumns  s orted in des cendingWhic h ty pe of c hart  in M S - E xcel  2 0 1 6 d is play s  both c o lumns  s orted in des cending
order  and a l ine repres enting the c umulat ive total  percentage?order  and a l ine repres enting the c umulat ive total  percentage?

A nsA ns 1. 
Waterfall chart 

2. Sunburst chart
3. Pareto chart
4. Histogram chart

Section : Basic Knowledge of Computer
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Q .62Q .62 In the M ic ros oft  E xcel  S preads heet ,  to  c reate a  s er ies  of  dates  that  inc rementsIn the M ic ros oft  E xcel  S preads heet ,  to  c reate a  s er ies  of  dates  that  inc rements
by  one day  eac h,  whic h of the fo l lowing ac t ions  s hould  y ou perform?by  one day  eac h,  whic h of the fo l lowing ac t ions  s hould  y ou perform?

A nsA ns 1. Enter the starting date, drag the fill handle and release.
2. Type each date manually.
3. Enter the starting date, then use the SUM function.
4. Use the AutoFit function.

Q .63Q .63 What is  a  ' template'  in M S  PowerPoint?What is  a  ' template'  in M S  PowerPoint?
A nsA ns 1. A group of pre-designed sheets

2. A group of pre-designed PDFs
3. A group of pre-designed pages
4. A group of pre-designed slides

Q .64Q .64
A nsA ns 1. 

2. 
3. 
4. 

Q .65Q .65 Whic h of the fo l lowing key board s hortc uts  is  us ed for  opening c l ipboard his toryWhic h of the fo l lowing key board s hortc uts  is  us ed for  opening c l ipboard his tory
whi le formatt ing text  in an M S  Word doc ument?while formatt ing text  in an M S  Word doc ument?

A nsA ns 1. Windows + C
2. Windows + V
3. Windows + S
4. Windows + Z

Q .66Q .66 What does  dragging the Fi l l  Handle from a cel l  c ontaining 'M onday '  do?What does  dragging the Fi l l  Handle from a cel l  c ontaining 'M onday '  do?
A nsA ns 1. It fills the cells with the current date.

2. It fills the adjacent cells with 'Monday'.
3. It fills the cells with blank values.
4. It creates a series of days of the week (Monday, Tuesday, etc.).
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Q .67Q .67 What is  c ontained in a  c ompres s ed ( z ipped)  file?What is  c ontained in a  c ompres s ed ( z ipped)  file?
A nsA ns 1. Encrypted data

2. Temporary internet files
3. One or more files and/or folders
4. Multiple executable files

Q .68Q .68 Whic h of the fo l lowing Windows  ut i l it ies  is  us ed to  modify  s y s tem s tartupWhic h of the fo l lowing Windows  ut i l it ies  is  us ed to  modify  s y s tem s tartup
s ett ings  and manage s y s tem s erv ices?s ett ings  and manage s y s tem s erv ices?

A nsA ns 1. Task Manager
2. Disk Cleanup
3. System Configuration
4. Event Viewer

Q .69Q .69 When c ompos ing an email ,  whic h field  s hould  be us ed to  s end the email  toWhen c ompos ing an email ,  whic h field  s hould  be us ed to  s end the email  to
mult iple rec ipients  without them s eeing eac h other ’s  addres s es?mult iple rec ipients  without them s eeing eac h other ’s  addres s es?

A nsA ns 1. Body
2. Cc
3. To
4. Bcc

Q .70Q .70 S elec t  the c orrec t  s teps  to  pr int  one or  s everal  works heets .S elec t  the c orrec t  s teps  to  pr int  one or  s everal  works heets .
A nsA ns 1. Select the worksheets > Select File > Print or Press Ctrl + P > Select the Print button

or adjust Settings
2. Select the worksheets > Select Insert > Print or Press Ctrl + P > Select the Print

button or adjust Settings
3. Select the worksheets > Select Data > Print or Press Ctrl + P > Select the Print

button or adjust Settings
4. Select the worksheets > Select Home > Print or Press Ctrl + P > Select the Print

button or adjust Settings
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Q .71Q .71 Whic h of the fo l lowing is  a  s ophis t ic ated form of a  c omputer  v irus  that  c an evadeWhic h of the fo l lowing is  a  s ophis t ic ated form of a  c omputer  v irus  that  c an evade
detec t ion by  c hanging its  c ode?detec t ion by  c hanging its  c ode?

A nsA ns 1. Polymorphic virus

2. Macro virus
3. Boot sector virus
4. Worm

Q .72Q .72 What happens  when y ou s elec t  the Run option for  an exec utable file in the Fi leWhat happens  when y ou s elec t  the Run option for  an exec utable file in the Fi le
Download d ia log box?Download d ia log box?

A nsA ns 1. The browser closes without any action.
2. The file is deleted immediately.
3. The file is opened and executed directly.
4. The file is downloaded and saved to your computer.

Q .73Q .73 Whic h option al lows  y ou to  apply  a  d ifferent font  s ize to  a  s mal l  port ion of textWhic h option al lows  y ou to  apply  a  d ifferent font  s ize to  a  s mal l  port ion of text
within a  larger  text  box without affec t ing the ent ire text  box?within a  larger  text  box without affec t ing the ent ire text  box?

A nsA ns 1. Character Spacing in the Advanced Font Settings
2. Selection Pane in the Home tab
3. Font Size in the Font group
4. Text Box Formatting in the Insert tab

Q .74Q .74 How frequently  does  an ant iv irus  s oftware need to  be upgraded?How frequently  does  an ant iv irus  s oftware need to  be upgraded?
A nsA ns 1. Monthly

2. As frequently as updates are available
3. Often
4. Yearly

Q .75Q .75 Whic h tec hnique is  mos t  frequently  us ed to  c hange margin values  in tenths  of anWhic h tec hnique is  mos t  frequently  us ed to  c hange margin values  in tenths  of an
inc h in M S  Word?inc h in M S  Word?

A nsA ns 1. Typing with a keyboard
2. Painting with a brush tool
3. Drag-and-drop interface
4. Using a voice-controlled assistant
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Q .76Q .76 When c ompos ing and s ending a new email ,  whic h of the fo l lowing ac t ions  ens uresWhen c ompos ing and s ending a new email ,  whic h of the fo l lowing ac t ions  ens ures
that  the email  is  s ent  to  mult iple rec ipients  without any  of them s eeing the otherthat  the email  is  s ent  to  mult iple rec ipients  without any  of them s eeing the other
rec ipients '  emai l  addres s es?rec ipients '  emai l  addres s es?

A nsA ns 1. Enter all email addresses in the 'To' field.
2. Enter all email addresses in the 'CC' field.
3. Enter all email addresses in the 'Reply-To' field.
4. Enter all email addresses in the 'BCC' field.

Q .77Q .77 The S tart  menu was  firs t  introduced in whic h vers ion of Windows?The S tart  menu was  firs t  introduced in whic h vers ion of Windows?
A nsA ns 1. Windows 95

2. Windows 8
3. Windows XP
4. Windows 3.0

Q .78Q .78 Whic h of the fo l lowing is  the c orrec t  way  to  enter  and edit  text  in an M SWhic h of the fo l lowing is  the c orrec t  way  to  enter  and edit  text  in an M S
PowerPoint  s l ide?PowerPoint  s l ide?

A nsA ns 1. Click on the Text Box placeholder and type your text
2. Right-click on a slide, choose Edit Text and then type within the content placeholder

to enter text
3. Select the Insert tab, choose WordArt and then double-click the Slide Content Area

to enter and edit the text
4. Double-click on the Slide Title to enter text and press Enter to save the changes

Q .79Q .79 Whic h of the fo l lowing features  are c ommonly  found in the lates t  ant iv irusWhic h of the fo l lowing features  are c ommonly  found in the lates t  ant iv irus
s oftware to  enhance protec t ion agains t  malware?s oftware to  enhance protec t ion agains t  malware?

A nsA ns 1. Enhanced graphic design and user interface
2. Real-time scanning and automatic updates
3. Manual updates and limited malware database
4. Increased system resource usage and slow performance
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Q .80Q .80 Whic h feature in M S - Word proces s ing s oftware a l lows  y ou to  c hec k  for  s pel l ingWhic h feature in M S - Word proces s ing s oftware a l lows  y ou to  c hec k  for  s pel l ing
and grammatic al  errors?and grammatic al  errors?

A nsA ns 1. Macro
2. Mail Merge

3. Template
4. Spell Check

Q .81Q .81 A  pers on c an c omplete a  journey  in 2 0  hours .  He c overs  the firs t  one- third  partA  pers on c an c omplete a  journey  in 2 0  hours .  He c overs  the firs t  one- third  part
of the journey  at  a  rate of 68 km/ hr  and the remaining d is tance at  a  rate of 3 4of the journey  at  a  rate of 68 km/ hr  and the remaining d is tance at  a  rate of 3 4
km/ hr.  What is  the total  d is tance ( in km)  of his  journey ?km/ hr.  What is  the total  d is tance ( in km)  of his  journey ?

A nsA ns 1. 811
2. 816
3. 807
4. 813

Q .82Q .82 A  was hing mac hine manufac turer  earns  2 0 % profit by  s el l ing eac h was hingA  was hing mac hine manufac turer  earns  2 0 % profit by  s el l ing eac h was hing
mac hine for  ₹1 8 ,0 0 0 .  I f  the produc tion c os t  is  inc reas ed by  1 0 %, what s hould  bemac hine for  ₹1 8 ,0 0 0 .  I f  the produc tion c os t  is  inc reas ed by  1 0 %, what s hould  be
the new s el l ing pr ice of the mac hine s o  as  to  gain 1 0 %?the new s el l ing pr ice of the mac hine s o  as  to  gain 1 0 %?

A nsA ns 1. ₹18,150
2. ₹20,150
3. ₹18,550
4. ₹20,550

Q .83Q .83 E ven after  giv ing a 1 0 % dis c ount ,  Yudhvir  earned a profit of 1 0 % by  s el l ing a  bookE ven after  giv ing a 1 0 % dis c ount ,  Yudhvir  earned a profit of 1 0 % by  s el l ing a  book
marked for  ₹1 ,1 0 0 .  How muc h profit ( in ₹)  d id  he earn?marked for  ₹1 ,1 0 0 .  How muc h profit ( in ₹)  d id  he earn?

A nsA ns 1. 100
2. 110
3. 200
4. 90

Section : Quantitative Aptitude
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Q .84Q .84 The average weight of 50  s tudents  of a  s c hool  is  55 kg.  I f  the weight of theThe average weight of 50  s tudents  of a  s c hool  is  55 kg.  I f  the weight of the
teac her  is  inc luded ,  the average weight inc reas es  by  2 0 0  grams .  Find the weightteac her  is  inc luded ,  the average weight inc reas es  by  2 0 0  grams .  Find the weight
( in kg)  of  the teac her.( in kg)  of  the teac her.

A nsA ns 1. 65.2
2. 55.2
3. 58.2
4. 62.2

Q .85Q .85 A n item is  marked 1 2 5% higher  than its  c os t  pr ice.  E ven after  a l lowing s omeA n item is  marked 1 2 5% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome
dis c ount ,  the s hopkeeper  earned 1 7% profit .  F ind the d is c ount percentagedis c ount ,  the s hopkeeper  earned 1 7% profit .  F ind the d is c ount percentage
al lowed by  the s hopkeeper.a l lowed by  the s hopkeeper.

A nsA ns 1. 48%
2. 50%
3. 49%
4. 47%

Q .86Q .86 A  man s el ls  a  mobi le phone for  ₹60 0  and los es  s ome money .  I f  he had s o ld  it  forA  man s el ls  a  mobi le phone for  ₹60 0  and los es  s ome money .  I f  he had s o ld  it  for
₹1 1 1 0 ,  his  gain would  have been 4 .1  t imes  the ear l ier  los s .  The c os t  pr ice ( in ₹)  of₹1 1 1 0 ,  his  gain would  have been 4 .1  t imes  the ear l ier  los s .  The c os t  pr ice ( in ₹)  of
the mobi le phone is :the mobi le phone is :

A nsA ns 1. 700
2. 730
3. 720
4. 680

Q .87Q .87 The pr ice of a  laptop was  firs t  inc reas ed by  2 5% and then dec reas ed by  2 0 %.  I fThe pr ice of a  laptop was  firs t  inc reas ed by  2 5% and then dec reas ed by  2 0 %.  I f
the final  pr ice of the laptop is  ₹3 4 ,0 0 0 ,  what was  the or iginal  pr ice ( in ₹) ?the final  pr ice of the laptop is  ₹3 4 ,0 0 0 ,  what was  the or iginal  pr ice ( in ₹) ?

A nsA ns 1. 34,500
2. 34,000
3. 34,750
4. 33,750

Q .88Q .88

A nsA ns 1. 8
2. 7.2
3. 0.36
4. −5
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Q .89Q .89 In an elec t ion between two c andidates ,  1 0 % of the voters  d id  not  c as t  their  voteIn an elec t ion between two c andidates ,  1 0 % of the voters  d id  not  c as t  their  vote
and 1 0 % of the votes  pol led  were found inval id .  The s ucces s ful  c andidate got  64%and 1 0 % of the votes  pol led  were found inval id .  The s ucces s ful  c andidate got  64%
of the val id  votes  and won by  a  major ity  of  9 ,0 72  votes .  F ind the number ofof the val id  votes  and won by  a  major ity  of  9 ,0 72  votes .  F ind the number of
regis tered voters  in that  elec t ion.regis tered voters  in that  elec t ion.

A nsA ns 1. 46,000
2. 40,000
3. 42,000
4. 48,000

Q .90Q .90 Pipes  A  and B  c an fil l  a  tank  in 1 0  hours  and 4 0  hours ,  res pec t ively .  C  is  an outletP ipes  A  and B  c an fil l  a  tank  in 1 0  hours  and 4 0  hours ,  res pec t ively .  C  is  an outlet
pipe attac hed to  the tank .  I f  a l l  the three pipes  are opened s imultaneous ly ,  itpipe attac hed to  the tank .  I f  a l l  the three pipes  are opened s imultaneous ly ,  it
takes  80  minutes  more than the t ime that  A  and B  together  take to  fil l  the tank .takes  80  minutes  more than the t ime that  A  and B  together  take to  fil l  the tank .
I f  pipes  A  and B  are opened at  the s ame t ime in an empty  tank  and c los ed after  7If  pipes  A  and B  are opened at  the s ame t ime in an empty  tank  and c los ed after  7
minutes ,  then in how muc h t ime c an pipe C  empty  the part ia l ly  fil led  tank?minutes ,  then in how muc h t ime c an pipe C  empty  the part ia l ly  fil led  tank?

A nsA ns 1. 47 hours
2. 45 hours
3. 49 hours
4. 51 hours

Q .91Q .91 E valuate:  3 5 − [ 2 5 − { 3 1  − ( 2 1  − 1 4  + 8) } ]E valuate:  3 5 − [ 2 5 − { 3 1  − ( 2 1  − 1 4  + 8) } ]
A nsA ns 1. 29

2. 25
3. 26
4. 23

Q .92Q .92 The number 2 80  is  inc reas ed by  2 0 %, and 55 is  added to  it .  F ind the res ultantThe number 2 80  is  inc reas ed by  2 0 %, and 55 is  added to  it .  F ind the res ultant
number.number.

A nsA ns 1. 335
2. 405
3. 395
4. 391
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Q .93Q .93 Three pipes ,  A ,  B  and C ,  c an fil l  up a  c is tern in 24 ,  3 0  and 4 0  minutes ,Three pipes ,  A ,  B  and C ,  c an fil l  up a  c is tern in 24 ,  3 0  and 4 0  minutes ,
res pec t ively .  P ipe A  is  a lway s  open,  whi le pipes  B  and C  work  a lternately  for  ares pec t ively .  P ipe A  is  a lway s  open,  whi le pipes  B  and C  work  a lternately  for  a
minute eac h,  s tart ing with pipe B.  How long wi l l  i t  take to  fil l  the c is tern?minute eac h,  s tart ing with pipe B.  How long wi l l  i t  take to  fil l  the c is tern?

A nsA ns 1. 

2. 

3. 

4. 

Q .94Q .94 4  y ears  ago ,  the average age of A ,  B,  and C  was  70  y ears .  4  y ears  from now,  the4  y ears  ago ,  the average age of A ,  B,  and C  was  70  y ears .  4  y ears  from now,  the
average age of A  and C  wi l l  be 88 y ears .  What wi l l  be the age ( in y ears)  of  B,  3average age of A  and C  wi l l  be 88 y ears .  What wi l l  be the age ( in y ears)  of  B,  3
y ears  from now?y ears  from now?

A nsA ns 1. 60
2. 59
3. 54
4. 57

Q .95Q .95 The rat io  of  V imal 's  age to  Pradeep's  age is  4  :  3.  V imal  wi l l  be 3 0  y ears  o ld  afterThe rat io  of  V imal 's  age to  Pradeep's  age is  4  :  3.  V imal  wi l l  be 3 0  y ears  o ld  after
6  y ears .  How o ld  is  Pradeep now?6 y ears .  How o ld  is  Pradeep now?

A nsA ns 1. 16 years
2. 17 years
3. 15 years
4. 18 years

Q .96Q .96 A  man s pends  2 5% of his  inc ome on food ,  2 5% on c hi ldren’s  educ at ion and 80 %A  man s pends  2 5% of his  inc ome on food ,  2 5% on c hi ldren’s  educ at ion and 80 %
of the remaining on hous e rent  and grocer ies .  What percentage of his  inc ome isof the remaining on hous e rent  and grocer ies .  What percentage of his  inc ome is
left  with him?left  with him?

A nsA ns 1. 12%
2. 5%
3. 10%
4. 15%

Q .97Q .97 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 1 1 ) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 1 1 ) } ]
A nsA ns 1. 1666

2. 1521
3. 1451
4. 1591
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Q .98Q .98 The average of the marks  of 1 5 s tudents  in a  c las s  is  52 .  I f  the marks  of eac hThe average of the marks  of 1 5 s tudents  in a  c las s  is  52 .  I f  the marks  of eac h
s tudent are doubled ,  find the new average.s tudent are doubled ,  find the new average.

A nsA ns 1. 104
2. 15
3. 52
4. 30

Q .99Q .99

A nsA ns 1. 
           

2 . 

3. 
            

4. 
           

Q .1 0 0Q .1 0 0 Rama c an row ups tream at  6  km/ hr  and downs tream at  8  km/ hr.  F ind Rama’sRama c an row ups tream at  6  km/ hr  and downs tream at  8  km/ hr.  F ind Rama’s
s peed in s t i l l  water  and the rate of the c urrent ,  res pec t ively .s peed in s t i l l  water  and the rate of the c urrent ,  res pec t ively .

A nsA ns 1. 5 km/hr and 2 km/hr
2. 3 km/hr and 1 km/hr
3. 7 km/hr and 6 km/hr
4. 1 km/hr and 7 km/hr
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